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1. [bookmark: _Toc160782776]General
[bookmark: _Toc160782777]1.1 Reference to internal or external textual or graphic objects is made by explicit naming, not solely by means of a description via visual or auditory features.
What is meant by this? 
Reference must be made to the objects used by explicitly naming and describing them in the existing text. Internal textual objects refer to texts, headings, footnotes, endnotes and text fields. External textual objects are, for example, hyperlinks. Graphical objects, on the other hand, include images, shapes, diagrams, tables, SmartArt and WordArt. All these objects may not only be referenced by their visual and auditory characteristics such as colour, size, shape, position, volume or pitch, but also require a clear designation in text form. It is advisable to give the object a meaningful name directly in the text, link to it and refer to it in the description. 
Why is it important:
For the accessibility of presentations, it is important that textual or graphic objects are understandable regardless of a particular sensory characteristic, such as sight or hearing. Recipients who primarily use one sensory channel (visual or auditory) may otherwise not be able to perceive this information. For example, staff, people with visual impairments or blindness may have difficulty understanding the content of objects if the content is only recognisable through visual features or descriptions. While recipients with hearing impairments or deafness may have difficulty forming a picture of an object based on descriptions that refer exclusively to acoustic features.
By clearly naming and describing textual and graphic objects, presentations become accessible to all recipients and provide orientation. 
How can I implement/check this?
If you want to write a precise reference for an internal or external textual or graphical object in PowerPoint, it is advisable to follow the steps below:
1. Firstly, you should make sure that the object has a clear and concise name. 
2. You should then describe the object in one or two sentences to convey its function and meaning. Use clear and precise language to avoid misunderstandings. 
3. Next, it is advisable that you add a unique identifier, such as a number or letter, to clearly identify the object. This is particularly important if you refer to several objects on the slide. 
4. Once you have the clear labelling and description of the object, you can insert the reference into the text. Use the labelling and description consistently to make your reference clear and precise.
The following list contains recommended formulations for textual references to objects in PowerPoint:
1. As shown/visible in the table/figure [number]...
2. As shown in [author(s), year]...
3. As described/mentioned in [slide title, page/paragraph number]...
4. As noted in [name of study, year]....
5. As shown/mentioned in the previous [table/figure, section]...
6. As shown in the data/results of [study name, year]...
7. As mentioned/said in [author(s), year, page/paragraph number]...
8. As mentioned/explained in the [section or chapter number]...
9. As can be seen in the red sphere [placement of the sphere on the slide]...
 
[bookmark: _Toc160782778]1.2 The use of colours is generally sparing.
What is meant by this?
A restrained and appropriate use of colours to convey information should be aimed for. Before the integration of colours in an information medium, it is advisable to carefully consider whether and to what extent they can contribute to improving the conveyance of information. 
Why is it important? 
For some recipients, too much colour can be a distraction or disrupt the reading flow due to strong stimulus perception. In addition, there are recipients who cannot perceive all colours clearly or who work independently of colour presentation. If information is conveyed exclusively through colour, these recipients may miss important information or not understand it. 
How can I implement/check it? 
It is recommended that the number of colours used is limited to what is necessary to convey a clear and understandable message. In addition, when deciding on the use of colours, consideration should also be given to their necessity in order to ensure that they actually offer added value for the communication of information. 
If colours are nevertheless used to convey information, this information should also be conveyed in other ways, such as symbols, lettering or patterns (see 1.3).
 
[bookmark: _Toc160782779]1.3 If colours are used to convey information (e.g. in diagrams or to mark text), labels, symbols or patterns convey the same information.
What is meant by this?
It is recommended that information is not only represented by colours, but also by labels, symbols or patterns. This means, for example, that colour AND pattern should be used in a diagram to represent a bar. For example, buttons in the colours green and red are also labelled with "yes" and "no". This creates opportunities to improve the perception of visual information. 
Why is it important? 
[bookmark: _Hlk139352896]If information is presented exclusively through colours, recipients who do not perceive all colours clearly may have difficulty understanding this information. There is a risk that information that is only conveyed via colours will be lost on such groups of people. For example, recipients with colour vision deficiency have difficulties perceiving certain colours or contrasts. Colours with the same saturation can prevent full perception of what is shown and result in not all information being absorbed. Grey contrasts should also only be used to a limited extent, as recipients with colour vision problems may have difficulty recognising certain shades of grey or differences in brightness. 
Through the additional use of labels, symbols or patterns, information can be presented in several ways to ensure that it is also accessible to groups of people who work independently of the colour display, are distracted by bright colours or perceive stimuli very strongly. 
How can I implement/check it? 
There are different procedures for Mac and Windows operating systems for implementation and testing:
For example, to add a pattern to a diagram in PowerPoint, you can proceed as follows:
For Mac:
1. Click on the diagram to select it. A frame should now appear around the diagram.
2. Click on the area of the diagram that is to contain a (different) colour and a pattern.
3. Right-click to open a pop-up menu. Select "Format data series". A window appears on the right-hand side. 
4. Under "Filling", select a strong colour under "Single-colour filling". 
5. Finally, under "Pattern fill", select a clearly recognisable pattern that you have not yet used in the colour combination in this diagram.
For Windows:
6. Click on the diagram to select it. A frame should now appear around the diagram.
7. Click on the "Format" tab at the top of the menu bar to display the formatting options for the chart, on the left hand side you will find a drop down menu where you can select which part of the chart you want to edit. 
8. In the "Format" tab, you will find a button with the name "Fill effects". Click on it to open the menu for filling the diagram.
9. Select the "Structure" option from the "Fill effects" drop-down menu
10. Select a pattern by clicking on it. You can choose from a variety of patterns, including diagonal lines, dots, crosses and more.
You should also add a caption to each chart in PowerPoint and proceed as follows:
For Mac: 
1. Click on Print layout in the View menu.
2. Click on the diagram and then on the Draft diagram tab.
3. Click on "Add diagram element" and then on "Data labels" and or "Axis title" and select the desired title option.
4. Select the position of the data labels here. If the data for the table is not generated, enter it manually.
5. Change the font, font size and font colour of the label by clicking on the corresponding buttons in the menu bar.
6. Position the labelling at the desired location by dragging it with the mouse.
7. Repeat this process for any other labelling you wish to add.
For Windows:
1. Click on the diagram to select it. This displays the diagram tools at the top of the menu bar.
2. Click on the "Diagram design" tab, which is located directly above the menu bar, to access the diagram tools.
3. In the "Add diagram elements" section, click on the "Data labels", "Axis title" or "Diagram title" button to display a list of labelling options.
4. Select the label you want to add.
5. Enter the text for the caption by clicking on the text field that appears on the slide.
6. Change the font, font size and font colour of the label by clicking on the corresponding buttons in the menu bar.
7. Position the labelling at the desired location by dragging it with the mouse.
8. Repeat this process for all other labels that you want to add.
Diagrams and other representations should be viewed in different ways for testing, for example by fading out colours or changing the brightness to ensure that the information is easy to understand regardless of colour. There are various ways to do this. 
Print the respective slide in greyscale to get an idea of what your displays look like without colours. In addition, you can set the brightness of your end device from "very high" to "very low" and check whether the information is still accessible.

[bookmark: _Toc160782780]2. Presentation 
[bookmark: _Toc160782781]2.1 The main language of the presentation corresponds to the language of the spell check.
What is meant by this? 
It is important that the language set for the spell checker in PowerPoint matches the language that is primarily used in the presentation. If multiple languages are used in a presentation, the language for certain sections or words can be changed manually to ensure that the spell checker works correctly. 
Why is it important? 
It is important that the main language of the presentation matches the language of the spell checker to ensure that the presentation is read out correctly in terms of pronunciation using speech output programmes. Otherwise, a presentation may be difficult to understand for recipients with limited reading ability, learning difficulties or visual impairments who receive presentations with the support of a screen reader or voice output programme. If the actual language does not comply with the spell checker, this can lead to incorrect pronunciation by the speech output programmes, so that the content of the presentation is misunderstood or distorted in its meaning.
How can I implement/check it? 
To customise the main language in a document, there are different procedures for Mac and Windows operating systems:
The main language of a PowerPoint presentation can be customised as follows:
For Mac: 
The main language in Mac cannot be customised. The main language applies during installation.
For Windows: 
1. Open the presentation and click on "File" in the menu bar.
2. Click on "Options" at the end of the menu.
3. Click on "Language" on the left-hand side of the window.
4. Select the desired language from the "Main language for documents" drop-down menu.
5. Click on "OK" to save the settings.
As soon as the main language of the presentation has been changed, PowerPoint's correction aids and spell checkers are automatically set to this language.

[bookmark: _Toc160782782]2.2 The title on the first slide is stored in the metadata, meaningful and easy to understand.
What is meant by this?
It is important to make the title of a presentation easy to understand and meaningful, which means that the title should be formulated in simple and clear words that adequately reflect the content of the presentation. The title should allow readers to quickly recognise what the presentation is about and what purpose it fulfils. This title must be stored in the metadata to make it easier for recipients to identify and organise the presentation. 
Metadata is information that describes or identifies a presentation and is usually invisible to viewers. It includes various properties, such as the title, the author, the creation date, the file format and the size of the file. Keywords or catchwords can also be used as metadata to describe the content of the presentation and make it easier to find for later searches or archiving.
Why is it important? 
A meaningful and easy-to-understand title that is stored in the metadata facilitates orientation and approval of a document for recipients who are dependent on speech output and screen readers. Recipients with visual impairments or learning difficulties cannot visually scan the presentation to determine whether it is relevant to them.  Instead, they have to rely on voice output and screen readers to understand the content. A meaningful and easy-to-understand title can help them quickly grasp the content of the presentation and decide whether or not they want to continue reading.
An example of a meaningful and easy-to-understand title would be "Guide to document accessibility". This title gives the reader a clear idea of what the presentation is about. A bad title, on the other hand, would be "Accessibility", for example. This title is too general and does not tell readers specifically enough what the content of the presentation is about, which leads to irritation and a considerable amount of time spent by readers with screen readers and voice output.
How can I implement/check it?
There are different procedures for entering the title of a document in the metadata, depending on the operating system: 
For Mac:
1. Click on "File".
2. Click on "Properties" in the "Summary" tab to access the metadata.  
3. Enter the title in the field provided.
For Windows: 
1. Click on "File" in the top left-hand corner of the screen.
2. Click on "Information".
3. Click on the input fields under "Properties" and enter the title in the field provided.
To check whether the title is correctly stored in the metadata, you can click on "File" and "Information" again. Here you should find the title that you entered previously.
Whether a title is ultimately meaningful or not is up to you to decide. But remember that reading decisions should already be made by the title.

[bookmark: _Toc160782783]2.3 More extensive presentations have a table of contents at the start date. 
What is meant by this? 
For more extensive presentations, a table of contents should be created to provide an overview of the sections of the presentation. In general, a presentation is considered extensive if it has several slides and the content is complex. 
A table of contents is a list of the chapters or sections of a presentation. It gives the reader an overview of the content and structure of the presentation and makes it easier to find specific topics or sections. The table of contents is usually located at the start of a presentation and indicates the page number on which the respective section begins. 
Why is it important? 
A table of contents proves to be extremely valuable for recipients who need a clear structure to find their way around an extensive presentation. It is an indispensable tool for orientation and navigation within the presentation and can save readers the time-consuming search for relevant information.
How can I implement/check it?
There are various ways to create a table of contents in PowerPoint. Two options for PowerPoint 2003 and 2007 are shown in the following history: 
1. Create all the slides first and only start creating the table of contents at the end. 
2. With PowerPoint 2003, you can open the "Slide sorting" function via "View" in the ribbon.
3. You can create a directory using the "Overview slide" or "Contents slide" functions that open. 
From version 2007 onwards, you will have to carry out the individual steps yourself:
1. Switch to the "View" ribbon and open the "Outline view". 
2. If you only want to include the headings in your table of contents, right-click in the outline and select "Reduce outline" > "Reduce all levels". 
3. Then select and copy ([Ctrl] + [C]) the outline on the left-hand side and right-click to create a "New slide". 
4. Now insert the outline here using the key combination [Ctrl] + [V]. Optionally, you can also write the slide number at the end of the line. 
5. The last step is to select a heading and move the slide to the correct position.

The table of contents is now displayed on the slide. You can move or resize it, just like any other object in PowerPoint.

[bookmark: _Toc160782784]3. Slide
[bookmark: _Toc160782785]3.1 Each slide has a meaningful title.
What is meant by this? 
Recipients should be given a quick and concise idea of what the respective slide is about. The title should therefore describe the content of the slide clearly and precisely in order to motivate the recipients to concentrate on the slide and understand the content better.
Why is this important? 
For recipients who navigate within a presentation using a screen reader or voice output, a meaningful title on each slide can help them to better understand the content of the presentation and find their way around it. Screen reader users navigate between the slide titles to find specific topics and grasp the content of the slides. A clear and precise title generally increases the approval and orientation of the presentation and individual slides. 
How can I implement/check it? 
To ensure that each slide has a meaningful title, you should first consider what message you want to convey with each slide. The title should focus on the core content of the slide and not be too general or too specific. An easy way to check the title is to consider whether the title succinctly and clearly describes the main message of the slide. 

[bookmark: _Toc160782786]3.2 There are no blank lines and no empty placeholders (text fields) in the presentation 
What is meant by this? 
Blank lines and empty placeholders are spaces between blocks of text or objects in the document that do not contain any relevant content or information. Blank lines are spaces between lines of text that do not contain any text content. Empty placeholders (text fields) are empty areas that are intended as placeholders for text or other content but have not yet been filled in. Empty lines and empty placeholders (text fields) should be avoided in a PowerPoint presentation. 
Why is it important? 
The absence of blank lines and empty placeholders is important as these elements can be interpreted as text by screen readers and voice outputs (read out as blank), which can cause confusion and difficulty in navigating through the presentation. However, if the presentation is designed so that it does not contain unnecessary blank lines or empty placeholders, navigation through the document can be more effective and accurate.
How can I implement/check it? 
It is not possible to display empty placeholders or empty paragraphs in PowerPoint. However, by simultaneously pressing the "Ctrl" and "F" keys and entering a "space", it is possible to search for specific spaces within the presentation.
When creating the presentation, it is important to ensure that you do not create empty spaces between paragraphs. Instead, it is advisable to use a new text box or a new slide. This prevents empty spaces from appearing on the slides.

[bookmark: _Toc160782787]3.3 The design is simple, e.g. no excessive use of transitions, sounds and graphics.
What is meant by this?
The design of the PowerPoint presentation should be kept simple and unpretentious, without excessive use of transitions, sounds and graphics. A simple design is a design that is simple and minimalist and dispenses with superfluous or unnecessary elements. It is characterised by a clear and concise design that focuses on the essentials and conveys a clear message.
Why is it important?
A simple and straightforward presentation makes it easier to use screen readers or voice output, as there are fewer distractions. In addition, a clear structure and minimalist design improves the readability and comprehensibility of the presentation for all recipients, but especially for recipients with concentration difficulties, excessive demands, learning difficulties or cognitive impairments.
How can I implement/check it? 
To realise a simple and minimalist design in PowerPoint, only a few transitions and effects should be used. A clear and simple design with a clear font type and a sufficient font size should be favoured. Such fonts are characterised by clear lines, balanced proportions and distinct letter shapes, which help to improve readability. Graphics should only be used if they are absolutely necessary to illustrate content. Colours should also be used sparingly and in high contrast to improve readability (see 1.2).

[bookmark: _Toc160782788]3.4 The templates (slide masters) provided in PowerPoint are used, with changes if necessary. The placeholders are filled according to their meaning.
What is meant by this?
There are ready-made templates in PowerPoint, which are known as slide masters. These templates contain placeholders for text, images and other content, which usually have a specific meaning and structure. By filling these placeholders according to their meaning, it is possible to ensure that the document is well structured and that all information is presented clearly and comprehensibly.
Why is it important?
A clear structure and standardised placeholders are very important for recipients with speech output or the need for structure in PowerPoint presentations. This makes navigation easier and improves the use of voice output and screen readers, which can use standardised placeholders to identify and lecture content.
How can I implement/check it? 
To use slide masters in PowerPoint, proceed as follows, depending on your operating system:
For Mac: 
1. Go to "Slide master" in the menu under "View".
2. Then click on the top slide ("Edit master title format") in the navigation area on the left-hand side if you want to customise all slides equally. Select a corresponding slide if you only want to customise certain slide types.
For Windows:
1. Open your PowerPoint presentation and select the "View" tab in the menu bar.
2. Select "Slide master" and a new window will open in which you can edit various master slides.
3. Select a master slide that corresponds to the layout of your slides.
4. Change the layout by adding or removing placeholders or adjusting their size and position.
5. Customise the design and colours of the master slide by using the "Colour scheme" and "Fonts" menu.
6. Save the changes by clicking on "Close master view".
Once you have edited the slide master, all slides in your presentation are automatically updated to display the new layout and design. 

[bookmark: _Toc160782789]3.5 The header, footer and slide numbers are created with appropriate placeholders, marked as decorative and free of relevant information.
What is meant by this?
The header, footer and slide numbers in PowerPoint are important elements for orientation, but should not contain any relevant information. Instead, they should be provided with placeholders such as "Date" or "Title".
Placeholders in PowerPoint are predefined text fields or symbols that are automatically filled with specific content, such as slide numbers, date or time. Placeholders can be used in the header and footer to display recurring elements such as the company logo or presentation titles on each slide. Placeholders for slide numbers, for example, give viewers an orientation within the presentation.
The header, footer and slide numbers should be labelled according to their content. In PowerPoint, these can be marked as "decorative" to signalise that they do not contain any essential content for the presentation and can therefore be skipped by screen readers and voice output. 
Why is it important?
It is important to keep headers and footers free of relevant information, as screen readers and voice output devices often do not read out information from headers and footers and important information could therefore be overlooked. If headers and footers are read out by screen readers and voice output devices, this disrupts the reading flow because they are read out again on every page
How can I implement/check it?
To design the header and footer with placeholders, proceed as follows, depending on your operating system:
For Mac: 
1. Click on "Insert" in the menu bar.
2. Select "Header and footer" there. A pop-up window appears. 
3. There you can select what you want to have in the header and footer and whether the content should also be displayed on the title slide. 
4. Once you have clicked on "Apply to all", the corresponding text fields will appear on the slides.
You can mark the header and/or footer as decorative. To do this, select the Footer text field. Right-click to open a menu. Select "Display alt text..." and a window will appear on the right-hand side. Select the "Mark as decorative" option there.
For Windows:
1. Click on "Insert" in the menu bar.
2. Select "Header and footer" there.
3. Click on the "Header" and/or "Footer" checkbox.
4. Use placeholders such as "Date" or "Title" and mark the elements as decorative.
5. Click on "Slide number" and select the desired position and formatting.
6. Save your changes.
You can decoratively mark the header and/or footer by selecting the text field of the footer. Right-click to bring up the menu and select the "Display alt text..." option. A window will appear on the right-hand side. Here you can select the option "Mark as decorative".

[bookmark: _Toc160782790]3.6 The reading order for the elements of a slide is logical (exception for decorative elements).
What is meant by this? 
It is important to place the content on the slides in PowerPoint in an intended and logical reading order so that the elements of a slide can be (pre-)read in a meaningful and understandable sequence. Elements such as headings, texts, graphics and other media should be organised in a comprehensible structure and reading order. The reading order should correspond to the visual arrangement of the elements on the slide.
Why is it important? 
A logical reading order is important to ensure that recipients who rely on screen readers or speech output are able to understand the content of a slide in an understandable way. If the reading order of the elements is not logical, this can lead to confusion and make approval of the content difficult or even impossible, as the screen reader or voice output reads the content in a jumbled manner. Contexts within a slide can be lost and references misunderstood.
How can I implement/check it?
To ensure that the reading order is logical, the elements of a slide should be created in the order in which they are to be read on the slide. Headings and texts should also be organised in a comprehensible structure. If graphics or other media are used, they should be linked to the corresponding texts or headings so that their meaning is clear. Attention should also be paid to a clear visual arrangement of the elements so that the reading order corresponds to the visual arrangement.
The reading order within a slide can be checked as follows: 
For Mac (not accessible):
1. Select the film to be checked.
2. Go to "Arrange" in the top menu ribbon and select "Rearrange objects".
3. A new window appears. The objects are shown there on individual, transparent slides in diagonal order. The order of the slides is from front (1) to back. 
4. Hold down the left button on your computer mouse and move the slides to the position where the corresponding element should be according to the reading order.
5. Then click on "OK".
Make sure that the title at the front (1) and the footer at the back are in reading order.
For Windows:
1. Select the slide for which you want to check the reading order.
2. Click on the "Check" tab.
3. Select "Reading order range" from the "Check accessibility" section.
4. The "Reading order area" window opens. In this window, you will see a list of all elements on the slide in the order in which they are read.
5. Check the list for logical and comprehensible sequence.
6. If the order does not make sense, click on the element in the list that you want to move and drag it to the desired position.
7. Check the reading order again to ensure that it now makes sense and is understandable.
8. Repeat this process for each slide in your presentation.
[bookmark: _Toc160782791]4. Text
[bookmark: _Toc160782792]4.1 The text passages that differ from the main language are marked with the appropriate language (language change).
What is meant by this? 
If a presentation is written in several languages, it is important to indicate passages that differ from the main language in the other language. 
The main language of a presentation is the language that is used most frequently in the presentation and that best describes the content. Defining the main language of a presentation is important as it determines which spell checker, grammar checker and other language-specific functions are used.
A language change refers to the change of language for a specific section or word in a presentation that differs from the main language. If sections or words within a presentation are required in another language, for example when using quotations, foreign-language terms or in a multilingual presentation, these must also be marked with the corresponding language.
Why is it important? 
Marking language changes is important for the accessibility of presentations, as it helps recipients who use a voice output to better understand the text and the presentation. 
If this person uses a screen reader or voice output to read the presentation, they may have difficulty recognising and understanding text passages that differ from the main language, as screen readers and voice outputs do not automatically recognise different language and pronunciation is based on the stored language. 
Marking language changes therefore enables screen readers and voice outputs to use the correct pronunciation.
How can I implement/check it? 
There is a setting in PowerPoint that allows you to highlight the language of the text. This function is normally referred to as "language labelling" and is available in PowerPoint to perform spell checking and grammar checking in the correct language.
Here are the steps for Mac and Windows to activate voice labelling in PowerPoint:
For Mac:
1. Click on "Extras" in the menu bar at the top.
2. Select "Language..." from the drop-down menu.
3. Another menu opens with the available language options. Select the desired language from the list.
4. Click on "OK" to accept the language setting.
You will also find the language function in the bottom bar of the window.
For Windows: 
1. Select the text that is to be labelled in a different language.
2. Click on the "File" tab and select "Options".
3. Click on "Language".
4. Under "Select the language used in this document", select the language you wish to use. You can also select several languages if you are writing in different languages.
5. Click on "OK" to save the settings.
Once you have activated language labelling, the language of the text is automatically recognised and highlighted. 
Alternatively, it is also possible to change the language of the presentation in the bar below the presentation using the "Language" function.
It is also possible to customise the language for individual slides in the presentation. To do this, proceed as follows:
1. Select the slide whose language is to be customised.
2. Click on "Check" in the menu bar.
3. Click on "Language" in the toolbar and select the desired language from the drop-down menu.

[bookmark: _Toc160782793]4.2 The font is sans serif (e.g. Arial, Helvetica) and not too thick or too thin.
What is meant by this? 
It is advisable to choose a sans serif font that is neither too thick nor too thin to ensure optimum legibility. The main focus here is on recognising and distinguishing individual letters and words.
Serifs are small decorations or lines that are attached to the ends of the letters. Sans serif fonts have clear and smooth lines and appear more modern and simple than fonts with serifs.
It is important that the stroke width of fonts is between 10% and 20% of the centre length to ensure sufficient contrast. Fonts without serifs, where the difference between the thickness of the lines of the letters is small, are best suited and correspond to the "Normal" or "Regular" weights. Fine and bold font weights and fonts with high line weight contrast should be avoided, especially when formatting the entire text.
Why is it important? 
Sans serif fonts are easier to decipher, especially for recipients who have difficulty following the reading flow or recognising and reading the text. This is because fonts with serifs (e.g. New Times Roman) can cause letters to blur into one another or be more difficult to read for some recipients, as the serifs vary the letter shapes more. In addition, fonts that are too thin or too thick can impair legibility, especially for recipients with impaired vision.
How can I implement/check it? 
In order to select fonts that are suitable for recipients with visual impairments, the recognisability, distinctiveness and openness of the characters as well as a low line width contrast should be taken into account. Different font classifications and design principles can influence these factors. The following fonts are therefore recommended: Arial, Calibri Regular, Helvetica, Lucida Sans Regular, Verdana Regular, Noto Sans Regular, Open Sans Regular, Source Sans Pro Regular and Fira Sans Regular.
You can set the font in PowerPoint in various ways:
1. Open your presentation and select the "Start" tab. There you will find the "Font" option, which you can use to set a new font for the selected text.
2. Use the "Font" drop-down menu: Right-click on the text whose font you want to change and select "Font". You can then select a new font from the list.
3. Select a sans serif font such as Arial, Helvetica or Verdana from the font selection.
A manual check of the presentation by the recipients is recommended, if possible, to ensure that the font is clear and easy to read, is not too thin or too thick and is not italicised or underlined.

[bookmark: _Toc160782794]4.3 Emphasis using capital letters, italics, bold, underlining or text effects (colour gradient as colour fill, glow effects, text outline) is used sparingly.
What does that mean?
The highlighting of text passages using capital letters or text effects such as colour gradients, glow effects or text contours should be used sparingly. In addition to capital letters, such highlighting can also include italicised and bold text, underlined text and text effects, as well as shadows, soft edges, relief, reflections or a luminous look. These emphasisations should be limited to individual words at most so as not to disrupt the flow of reading and to ensure a clear structure. It is important to ensure that the font is sans serif and not too thick or too thin (see 4.2).
Why is it important? 
Highlighting with capital letters or eye-catching text effects can disrupt the reading flow and impair the readability of the text. If, for example, important information is highlighted with various text effects such as glow effects, colour gradients and other highlights, this can distract readers from the actual content. However, a clear structure and easy readability are particularly important for recipients who have difficulty following the flow of the text or recognising/reading it. Many effects and highlighting can also have an overstimulating effect.
How can I implement/check it? 
To check the text for highlighting, proceed as follows: 
1. Take a look at the presentation.
2. Search for text passages that have been highlighted in bold, italics or coloured markings.
3. Consider whether the means used actually offer added value for understanding.
4. If in doubt, remove the highlighting.
Remove italics and underlining:
1. Select the text that should not be italicised or underlined.
2. Click on the "I" (for italics) and/or the "U" (for underlining) in "Start" under "Font" to remove these formatting options.

[bookmark: _Toc160782795]4.4 The line spacing is at least 1.2 pt.
What is meant by this? 
Line spacing in PowerPoint refers to the vertical distance between the lines in a paragraph. For good readability, the line spacing should be at least 1.2 pt. or 120% of the character size. However, the line spacing should not be disproportionately large so as not to disrupt the flow of reading. 
Why is it important?
Line spacing that is too small can impair the legibility of texts and cause visual overload. This can make it difficult for the eyes to focus on the next section of the text, which can lead to a reduced reading speed and a higher error rate. In addition, small line spacing can also lead to increased eye strain and fatigue, especially in longer texts. 
Sufficient line spacing of at least 1.2 helps recipients who have difficulty reading or concentrating to follow the flow of the text and decipher the content better. It also helps to create a clear structure in the text.  Adequate line spacing makes it easier for the eyes to find the beginning of the line when skipping to the next line.  
How can I implement/check it?
 To set the line spacing in PowerPoint, follow these steps:
1. Select the text for which you want to change the line spacing.
2. Click on the "Start" tab in the menu bar at the top.
3. Search for the "Paragraph" group and click on the "Paragraph" icon or, if you are using a Mac, click on "Line spacing".
4. A field opens. You can change the line spacing here.
5. If you require a specific line height, you can enter this in the "Dimension" field or use the arrows next to the field.
6. Click on "OK" to save the changes.

[bookmark: _Toc160782796]4.5 The text is left-aligned.
What does that mean?
A left-aligned text is aligned to the left margin of the presentation. This means that all line beginnings are vertically aligned and the line ends run out freely on the right.
Why is this important?
Left-aligned formatting helps recipients who have difficulty following the flow of reading, as the lines of text start on a common left-hand margin and are therefore easier to follow. If the lines are of different lengths, it is easier to jump from one line to the next with the eyes. As justified text causes irregularly large spaces between words and more frequent word breaks, especially in narrow columns, left-aligned flush typesetting is preferable.
How can I implement/check it?
To left-align a text in PowerPoint, you can follow the steps below:
1. Select the text that you want to left-align.
2. Click on the "Start" tab in the menu bar.
3. Find the "Paragraph" group and click the "Align Left" icon, or if you're using a Mac, click "Left Align" (it looks like four L-shaped arrows pointing to the left).
Alternatively, you can also use the key combination "Ctrl + L" to left-align the text.
[bookmark: _Toc160782797]4.6 Paragraphs are not created with tabs or soft line breaks, but with paragraph breaks (i.e. there are no blank lines in the document).
What is meant by this? 
A new paragraph in a presentation should be created with a paragraph break instead of a tab or a soft line break. A paragraph break is a function that is used to end a paragraph and start a new paragraph on the next line. A paragraph break is used to start a new paragraph without inserting additional line spacing between the two paragraphs. 
Why is it important? 
It is important to avoid the use of soft line breaks and to use paragraph breaks instead. Recipients with screen readers navigate from paragraph to paragraph within texts and have the beginnings read out to them in order to grasp the content of the paragraph. If a soft line break is used to separate paragraphs, the screen reader does not recognise this as a new paragraph and "New line" or "Blank line" is read out, which can disrupt the reading flow.
This can make the text unnecessarily long and confusing for recipients who use a screen reader or voice output. It can also make the content of the presentation more difficult to grasp, as the connection between the paragraphs is distorted. Instead of blank lines, paragraph spacing should therefore be used to structure the text. Paragraph spacing adds additional space between paragraphs without causing unnecessary breakdowns when lecturing.
How can I implement/check it?
Line breaks are activated by default in PowerPoint. To check paragraphs anyway, you can follow the steps below:
1. Click on the text field in which you want to check the paragraph.
2. In the window that opens, search for "Format text effects" and click on the "Text box" icon (it looks like a book).
3. Now check whether there is a tick in front of the "Wrap text in form" field.
4. If there is no tick, tick the box and close the menu. 
By highlighting paragraphs, you can quickly check that all paragraphs in your text are formatted consistently and that there are no errors or inconsistencies.

[bookmark: _Toc160782798]4.7 Columns are not organised using tabs, but using the "Add or remove columns" function. The space between the columns is large enough to visually separate them from each other.
What is meant by this? 
When using columns in PowerPoint, it is advisable to use PowerPoint's "Add or remove columns" function. This can ensure a consistent display in a presentation. 
In PowerPoint, columns are a way of dividing the text in a presentation into several vertical sections. This allows long texts to be organised more clearly, for example, by dividing them into several columns. The columns can be the same size or have different widths. Depending on requirements, a different number of columns can be created, although not too many columns should be used for the sake of clarity. 
If several columns are used in a presentation, sufficient space should be left between these columns so that they stand out visually from one another and are easier for recipients to recognise. The space between columns should always be at least 6 mm.
Why is it important? 
If columns in PowerPoint are not created using the associated functions, but by manually inserting tabs or spaces, this can lead to problems with screen reader or speech output lectures. It is therefore important to use the relevant PowerPoint function to create columns to ensure that the presentation is barrier-free and accessible.
If the space between the columns is not large enough, this can impair the legibility of the presentation, as the text appears to overlap for some readers and therefore becomes illegible. For recipients with visual impairments or other limitations, such as dyslexia, it can be difficult to perceive the text spacing between closely spaced columns. In addition, if the text spacing is too narrow, the letters may merge for the recipients or words may be displayed incompletely.
By using an appropriate column width or spacing between the columns, readability can be increased so that all recipients can read the presentation without restrictions.
How can I implement/check it?
To insert columns in PowerPoint using the "Add or remove columns" function, you can follow the steps below:
1. Position the cursor at the point in the text where you want to insert the columns.
2. Click on the "Start" tab in the menu bar.
3. Find the group "Paragraph" and click on " Add or remove columns " (it looks like three small bars next to each other).
4. Select the number of columns you want to insert from the drop-down menu or enter the number manually.
If you want to remove the columns later, repeat steps 1-3 and then select "One column" from the drop-down menu.
To customise the columns in PowerPoint, you can follow the steps below:
1. Position the cursor at the point in the text where you want to insert the columns.
2. Click on the "Start" tab in the menu bar.
3. Find the "Paragraph" group and click on "Add or remove columns" (it looks like three small bars next to each other).
4. You can adjust the spacing between the columns under "More columns" or "More columns". 
By customising the columns in PowerPoint, you can ensure that your text is optimally formatted and presented.
To customise the columns in PowerPoint, you can follow the steps below:
1. Position the cursor at the point in the text where you want to insert the columns.
2. Click on the "Start" tab in the menu bar.
3. Find the "Paragraph" group and click on "Add or remove columns" (it looks like three small bars next to each other).
4. You can adjust the spacing between the columns under "More columns" or "More columns". 
By customising the columns in PowerPoint, you can ensure that your text is optimally formatted and presented.

[bookmark: _Toc160782799]4.8 Only content that is actually a list/enumeration is output as a list/enumeration. These are created with list or enumeration formats.
What is meant by this? 
List or enumeration formats in PowerPoint are special formatting options that can be used to create a list of items or points. There are two types of list formats in PowerPoint: unordered lists and ordered lists.
Unordered lists are lists in which the elements or items are marked with a symbol or a dot and the order plays a subordinate role. Ordered lists, on the other hand, are lists in which the elements or items are ordered numerically or alphabetically and the order is important.
In order to improve readability and comprehensibility, lists should be divided up sensibly. For example, advantages could be presented in one list and disadvantages in another. This structuring helps recipients to grasp and process the information more easily.
Overall, when using lists and enumerations, you should always ask yourself whether it is really necessary and sensible to use this formatting and whether it helps the recipient to grasp the content.
Why is it important? 
The use of manually generated bullets can lead to the list not being recognised as a coherent list and therefore being inaccessible. If a list is not read out correctly by voice output and screen readers, recipients may have difficulty recognising the number of items in the list or may not understand it completely or in context. As a result, important information may not be correctly recognised. With the support of list and enumeration formats for lists, screen reader users can perceive them as a list and interpret them coherently. 
Proper structuring of presentations is important for General approval. The use of lists or enumerations, if such a structure exists, facilitates navigation and improves the perception of the presentation. However, labelling text passages as lists or bulleted lists for visual distinction can lead to confusion and difficulties for screen reader and speech output users.
An example of a correct use of lists or enumerations would be a list of tasks that must be carried out in a certain order. An incorrect use of lists or enumerations, on the other hand, would be if a text passage is labelled as a list or enumeration for visual emphasis, although it is not a sequence or enumeration. 
How can I implement/check it?
To create a list or enumeration in PowerPoint, you can use the following procedures with the various software:
For Mac: 
1. Select the text you want to format.
2. Go to the "Start" tab in the menu bar at the top.
3. Locate the "Paragraph" group on the "Home" tab. In this group, you will find the "Bullets" button with a down arrow. 
4. Click on the arrow next to the button. A drop-down menu is displayed. 
5. Click on "Numbering and bullets". A new window opens with various formatting options.
6. In the "Bullets and numbering" window, you have the option of selecting different styles for your bulleted list.
For Windows: 
1. Click on the "Start" tab in the menu bar at the top of the page.
2. In the "Paragraph" group, click on the "Bullets" or "Numbering" button to select the appropriate format.
3. Enter your text and press the Enter key after each line. PowerPoint automatically adds the next bullet or numbering element.
You can also select different bullets and numbering formats by clicking on the arrow next to the corresponding buttons in the "Paragraph" group.
To check, search for content in the presentation that is displayed as a list or enumeration. Check whether each of these areas actually represents a list or enumeration. Lists and enumerations should be used to present a group of similar or related items. If you think that the content is incorrectly displayed as a bulleted or numbered list, you can fix this by simply removing the bullets using the "Del" or "Backspace" key. Alternatively, it is also possible to click on the list function again. 

[bookmark: _Toc160782800]4.9 Texts have a sufficient contrast ratio to the background of at least 4.5:1.
What is meant by this?
The contrast ratio in PowerPoint refers to the ratio between the brightness of the text and the background on which it is displayed. A high contrast ratio makes the text easier to read. A sufficient contrast ratio is achieved when the text colour stands out clearly from the background colour. The contrast ratio for normal texts is at least 4.5:1. Black text on a white background (or vice versa) represents the optimum contrast. If other colours are used, the contrast ratio must be checked.
Why is it important? 
A sufficient contrast ratio between text and background colour is of great importance, especially for recipients with impaired vision. If the contrast is not high enough, the text can be difficult or impossible to read, resulting in barriers to the approval of information.
For example, recipients with colour blindness have difficulty distinguishing between certain colours. A sufficient contrast ratio helps to ensure that they can still read the text. If the contrast ratio between the text and the background is low, it can be more difficult to read the text, even if it is large. 
Sufficient contrast not only makes it easier for recipients with visual impairments to perceive content. Recipients who work in an environment with poor lighting conditions, have a printout in black and white or are watching a presentation via a projector also benefit from a high contrast ratio. Sufficient contrast ensures that the content is clearly recognisable, making it easier to absorb and process information.
How can I implement/check it?
If you find that your presentation does not match the default contrast ratio of black and white, you can either change the font colour or adjust the background colour to increase the contrast ratio in PowerPoint. Here is a simple guide on how to do this:
1. Select the text for which you want to increase the contrast.
2. Click on the "Start" tab in the menu bar at the top of the page.
3. Click on the "Font colour" button under "Font " and select a colour with a higher contrast to the background colour. For example, if the background colour is dark, select a light font colour to increase the contrast.
It is also important to note that PowerPoint contains some accessibility templates that have been specially developed for recipients with visual impairments. If you use one of these templates, the contrast ratio is automatically optimised.
To ensure that the contrast ratio between text and background is optimal, you can use online tools or downloadable programmes. These can automatically calculate the contrast ratio for you. 
If in doubt, it is advisable to opt for a dark text (preferably black) and a light background (white), as the contrast ratio of at least 4.5:1 is always given here. 

[bookmark: _Toc160782801]5. Link
[bookmark: _Toc160782802]5.1 URL does not appear as plain text in the body text. Instead, hyperlinks are inserted, clearly labelled and easy to understand.
What is meant by this? 
A URL (internet address or web address in everyday language) should not simply be copied into a continuous text. Instead, the URL should be integrated using a hyperlink. This should be named with a meaningful and understandable title.
Hyperlinks are clickable links within a presentation or to other documents, websites or files. A hyperlink can be created in PowerPoint in various ways, for example by adding a link to a specific section of the presentation, inserting a link to an email or linking a text or image to a web page. Hyperlinks are a useful feature in PowerPoint as they allow you to navigate quickly and easily between different sections and resources. 
It is also important that such links are not labelled "here" or "this link" or "more information". This designation says nothing about exactly what information is meant and where it can be accessed.
Why is it important? 
Clear and precise naming of hyperlinks is very important to improve the approval of websites. If the URL is not replaced by a hyperlink, screen readers and speech output will lecture the complete URL (starting with "http"). It can therefore be very frustrating for screen reader users if the content of the link is not clear and the entire URL is read out instead. This can significantly impair the use of the presentation and approval of a website. 
How can I implement/check it?
To convert a URL into a hyperlink in PowerPoint, proceed as follows depending on the software (see also 5.2):
For Mac:
1. Select the text or object that is to contain the hyperlink.
2. Right-click or click on "Insert link" on the "Insert" tab. 
3. Enter the URL in the "Address" field or select the file to which the hyperlink should refer.
4. Click on "OK" to insert the hyperlink. The selected text or object is now displayed as a hyperlink.
For Windows:
1. Select the text or object that is to contain the hyperlink.
2. Click on the "Insert" tab in the menu bar at the top of the page or right-click.
3. Click on the "Link" button in the "Links" group.
4. In the window that opens, you can either insert a website URL or a link to a file on your computer. Enter the URL in the "Address" field or select the file to which the hyperlink should point.
5. Click on "OK" to insert the hyperlink. The selected text or object is now displayed as a hyperlink.

[bookmark: _Toc160782803]5.2 If a link opens another programme (e.g. browser, email programme), this is indicated in the link text. Example: "Contact address" (opens email programme)".
What is meant by this?
Hyperlinks can be integrated into PowerPoint that refer to various types of content, including programmes that are installed on the computer. If a hyperlink in PowerPoint refers to another programme, this programme is opened when the recipient clicks on the link.
It is important that the link text precisely describes the content of the link so that recipients know where they will be taken when they click on the link. If the link refers to another programme, such as an email programme or a file, this should be made clear in the link text. 
Why is it important?
Specifying the format or programme in the link text can help recipients to better understand the content of the link and decide whether or not they want to click on it.  
It is particularly important for screen reader and speech output users to understand the content of the link and the associated context. By specifying the format or programme in the link text, users of screen readers and speech output devices can better recognise that clicking on the link will, for example, open a different programme and thus a new window, and can adapt to this.
How can I implement/check it?
To ensure that the link text is unambiguous and clear, you should check it for comprehensibility. Is it immediately recognisable where the link leads and what action is being carried out? If not, you should adapt the link text to make it clearer.
You can also test if the link works as expected by clicking on it and performing the desired action. If there are any problems, you should update or repair the link to ensure that it works smoothly.

[bookmark: _Toc160782804]6. Heading
[bookmark: _Toc160782805]6.1 Titles are labelled exclusively with Arabic numerals ("1"), not with Roman numerals ("I").
What is meant by this?
In a list or in a title, only Arabic numerals (e.g. 1, 2, 3) should be used for numbering and not Roman numerals (e.g. I, II, III).
Arabic numerals are the most common way of writing numbers today. Roman numerals, on the other hand, are a way of writing numbers that uses letters of the Latin alphabet to represent numbers.
Why is it important?
The use of Arabic numerals represents the international standard for the representation of numbers and is used for the communication and exchange of information in different countries and languages. The use of Roman numerals in headings can pose a challenge for some recipients and lead to comprehension difficulties. This represents a linguistic barrier. Screen readers and voice outputs also have problems with the correct pronunciation of Roman numerals, as these can represent both letters and numbers. For example, the screen reader may read out "V" (for 5) as the letter "V" instead of the number "5", which can lead to confusion or misunderstandings. This can be particularly problematic in more complex presentations where clear and accurate numbering is important to understand the content
How can I implement/check it?
To ensure that only Arabic numerals are used for numbering in lists or titles in PowerPoint, you can perform the following steps depending on the software:
For Mac: 
1. Select the list or title you want to check.
2. Go to the "Start" tab in the menu bar at the top.
3. Locate the "Paragraph" group on the "Start" tab. In this group you will find the "Numbering" button with an arrow pointing downwards. 
4. Click on the arrow next to the button. A drop-down menu is displayed. 
5. In the drop-down menu that opens, click on the list of Arabic numbers.
For Windows:
1. Click on the "Start" tab in the menu bar.
2. Select the list or title you want to check.
3. Click on the "Numbering" icon in the "Paragraph" group.
4. In the drop-down menu that opens, click on the list of Arabic numbers.

[bookmark: _Toc160782806]6.2 Headings, figure and table captions appear only once, are meaningful and easy to understand. 
What is meant by this? 
Headings, figure and table captions should only appear once in a presentation to improve readability and clarity of the presentation. In addition, it is important that headings, figure and table captions are meaningful so that they quickly and effectively help readers to understand the content of the relevant sections or elements. Figure and table captions should also contain all the necessary information to help readers understand the data or information presented and, if necessary, refer back to the sources used. 
Why is it important? 
A clear structure is crucial for quickly grasping and understanding content. Headings and labelling play an important role here, as they help to structure the content of the presentation and quickly identify key sections and elements. This is particularly important for recipients with visual impairments, learning disabilities or reading difficulties, as clear structuring facilitates approval of content. A precise and meaningful heading, for example, enables readers to scan texts quickly and decide whether or not they want to continue reading. Figure and table labelling should also be precise and meaningful in order to enable easy comprehension and clear classification. Clear and precise labelling of figures and tables can also help to avoid misunderstandings and confusion, especially if several figures or tables appear in the same presentation. 
How can I implement/check it? 
When selecting headings, figure and table captions, you should follow a few principles to ensure that they are appropriate to the content and easy to understand:
1. Describe the content precisely: The heading or caption should be short and concise and describe the content of the document or figure/table.
2. Use clear and simple language: Avoid technical jargon and instead use language that is easy for the target group to understand.
3. Use keywords: Use relevant keywords that give recipients an idea of what they can expect to find in the document or figure/table.
4. Use formatting: Use a larger font size or bold type to emphasise the headline and make it easier to read.
5. Check accuracy: Make sure that the information in the heading or labelling is correct and does not lead to misunderstandings.
6. Avoid repeated labelling: Avoid repeating captions or headings in the document to avoid confusion.
7. Consider the target group: Make sure that the headline or labelling is tailored to the needs and knowledge of the target group.
8. Use the correct spellings and symbols: Use correct spelling and grammar, and use symbols and abbreviations that are understood by the target audience.
By following these principles, you can create headings, figure and table captions that are appropriate to the content and easy to understand.
The targeted placement of an image or table caption makes it possible to create a clear link between the caption and the associated element. As a rule, this function can be selected by simply right-clicking on the element, which makes it easier to place the label in the desired position and ensure that it does not appear isolated. 

[bookmark: _Toc160782807]7. Graphic
[bookmark: _Toc160782808]7.1 Graphics and videos contain a short, concise alternative text. Graphics and videos with no substantive meaning are marked as decorative.
What is meant by this? 
To improve the approval of a PowerPoint presentation, all graphics and videos contained in it should be provided with alternative texts that describe what can be seen. An alternative text is a short and concise description of the content of the graphic and video that is read by screen readers and speech output devices to understand the content.
In the case of purely decorative images or videos with no relevance to the content, these should be labelled accordingly. In PowerPoint, a graphic or video can be marked as "decorative" to indicate that it does not contain any content relevant to the presentation and can therefore be skipped by screen readers and voice output. 
Why is it important? 
A suitable alternative text for a graphic or video is important as it enables all recipients to understand the content. If there is no or insufficient alternative text, the graphic or video will be invisible to screen reader and speech output users. This means that these recipients miss out on important information that could be contained within the element.
An appropriate alternative text describes the graphic element briefly and concisely and conveys how the element relates to the content of the presentation. If the element contains important information that is not or cannot be presented differently in the text, it is important to include this information in the alternative text so that it can be recognised by screen readers and speech output. A detailed description of the graphic or video is generally not necessary for an alternative text. Elements that contain a lot of important information should appear in the text itself or provide a detailed text alternative. As a general rule, an alternative text should contain a maximum of 120 characters.
An example of an appropriate alternative text for a graphic would be: "A group photo of employees who took part in a company outing and are standing together in front of a mountain panorama." This alternative text provides recipients of a screen reader or voice output with a detailed explanation of what can be seen in the graphic. 
How can I implement/check it?
To add an alternative text for a video or graphic in PowerPoint, follow these steps depending on the software:
For Mac: 
1. Select an object. 
2. In the ribbon, select the "Shape format" tab for the object and then "Alt text".
3. In the Alternative text area, enter one or two sentences in the text field to describe the object and its context.
4. Alternatively, once you have selected the object, you can right-click and go to "Display alt text..." button. A pop-up window will then appear.
For Windows:
1. Click on the video or graphic to select it.
2. Click on the "Format" tab and on "Alt text" in the menu bar. 
3. An area called "Alt text" opens on the right-hand side of the screen. In this area, enter a description of the video or graphic that conveys the content and meaning for recipients. 
4. Check the alternative text to ensure that it contains the relevant information and is appropriate.
To mark videos or graphics as decorative in PowerPoint, follow these steps depending on the software:
For Mac: 
1. Select an object. 
2. In the ribbon, select the "Format" tab for the object and then "Alternative text".
3. Activate the "Mark as decorative" checkbox. The text input field is greyed out.
For Windows:
1. Click on the video or graphic to select it.
2. Click on "Alt text" on the "Format" tab in the menu bar or right-click. 
3. An area called "Alt text" opens on the right-hand side of the screen.
4. Click on the box next to "Mark as decorative" so that there is a tick in it and the video or graphic is marked as decorative. 

[bookmark: _Toc160782809]7.2 Complex images (e.g. comics, SmartArts, diagrams) have a detailed descriptive text alternative. 
What is meant by this? 
A detailed descriptive text alternative for an image contains a detailed description of the image content and its significance for the presentation. In contrast to an alternative text, which only contains a brief summary of the image content, a detailed descriptive text alternative should convey all the important details of the image that are necessary for the image to be understood. A full descriptive text alternative should use clear and concise language and include all the important information of the image, including colours, shapes, text, staff, people, places and actions depicted in the image. However, the text should not be redundant or superfluous and should be limited to the relevant information contained in the image.
If a text alternative is required for a visual representation, it should be provided either in the same presentation or in a separate document. If the text alternative is included in the same presentation as the image, it should be located near the image. This way, recipients who need an image description can easily find the text alternative. If the text alternative is provided in a separate document, a link to the text alternative should be included in the presentation and made accessible. 
Why is it important?
The use of fully descriptive text alternatives is an important aspect of digital content accessibility as they ensure that visually impaired recipients can understand the content of complex images and diagrams. A detailed descriptive text alternative can be particularly important if the image contains important information that cannot be presented in any other way in the text of the presentation. As complex images are often difficult to describe, it is essential that they are accompanied by a precise and detailed text alternative so that everyone can understand the content of the image.
An example of a detailed descriptive text alternative for a complex picture could look like this: "The picture shows a group of people sitting at a round table and discussing. In the centre of the table is a cake with "Happy Birthday" written on it. The staff, people are walking around the table, smiling and raising their glasses to toast the birthday. The room is decorated with balloons and garlands and you can see a band playing music in the background." The more important the details are for understanding the content, the more detailed they need to be described.
How can I implement/check it?
A descriptive text alternative should contain a precise and accurate description of the visual element (e.g. image, diagram, graphic) and convey its importance to the content of the document. Here are some steps that can help you create a good descriptive text alternative:
1. Identify the visual element: Think about which visual element is to be described and what information it contains.
2. Describe the visual element: Describe the visual element in as much detail as possible to ensure a clear picture of what is shown in the image or diagram.
3. Consider the context: Consider how the visual element fits into the context of the presentation and what information it conveys. Make sure that the text alternative helps the reader to understand the meaning of the visual element in the context of the presentation.
4. Use clear language: Use clear, simple language and avoid technical terms or abbreviations that may be difficult to understand.
5. Avoid redundancy: Avoid repeating information that already exists in the text of the document.
There are a few steps you can take to check your text alternatives:
1. Check whether the text alternative contains all the important information of the visual element.
2. Make sure that the text alternative is understandable and easy to read.
3. Check whether the text alternative makes sense in the context of the document and has a clear connection to the text or other visual elements.
4. Ask someone who does not know the information in the visual element to read the text alternative and check that they can understand the meaning and purpose of the visual element.
5. Check that the text alternative is not redundant, i.e. that it does not repeat any information already in the text.

[bookmark: _Toc160782810]7.3 No images or WordArt are used to display text ("font graphics"). (Exception: Essential font graphics have a meaningful alternative text. Redundant font graphics are labelled as decorative).
What is meant by this? 
It is recommended not to display text using font graphics. Instead, the text should be typed and formatted as actual text. If font graphics are still used, it is necessary to provide an alternative text that describes the content of the font graphic. If the font graphics are redundant and contain the same text as the surrounding text, they should be labelled as decorative.
Type graphics are graphics that consist entirely of text characters and symbols and do not contain images, photos or other visual elements. Type graphics are often used for the design of logos, posters, banners and other marketing materials. WordArt is a typeface graphic that allows recipients to design text in different styles and shapes. 
Why is it important?
The use of font graphics can lead to limitations in the accessibility of digital content, as they cannot be recognised by screen readers or voice output for recipients with visual impairments. If the text is entered and formatted as real text, it can be read more easily by assistive devices. However, if written graphics are used, it is important to provide alternative text to ensure that the content of the graphic can be understood by all recipients.
How can I implement/check it? 
To avoid font graphics in PowerPoint, you should enter and format the text as real text instead of inserting it as an image or WordArt. If you still use font graphics, you can specify an alternative text (see 7.1).
 
[bookmark: _Toc160782811]7.4 Graphic information-bearing elements (e.g. lines, neighbouring areas) have a minimum contrast of 3:1 to the background.
What is meant by this?
Graphic information-bearing elements are visual elements that convey information in a presentation. These include, for example, lines, neighbouring areas and other graphic "aids". If these are used in PowerPoint, they must have a minimum contrast of 3:1 to the background of the presentation. The minimum contrast refers to the ratio or difference in brightness or colour depth between the colours used in graphic elements and the background.  
Why is it important? 
For recipients with visual impairments, sufficient contrast between graphic elements and the background can be crucial for recognising them. Insufficient contrast makes it difficult to recognise and can lead to misinterpretation. It is therefore important that graphic elements such as images or buttons have a sufficient minimum contrast.
Sufficient contrast not only makes it easier for recipients with visual impairments to perceive content. Recipients who work in an environment with poor lighting conditions, have a printout in black and white or are watching a presentation via a projector also benefit from a high contrast ratio. Sufficient contrast ensures that the content is clearly recognisable, making it easier to absorb and process information.
How can I implement/check it?
There are various options in PowerPoint for realising a minimum contrast of 3:1:
1. Use high-contrast colours: Select colours that have a high contrast to each other, e.g. black on white or yellow on black.
2. Use the integrated colour schemes: PowerPoint offers a variety of integrated colour schemes that have been specially developed for good readability and contrast. These can be found under the "Design" menu item in the ribbon bar.
3. To ensure that the contrast ratio between graphic information-bearing elements and the background is optimal, you can use online tools or downloadable programmes. These can automatically calculate the contrast ratio for you.
However, it is important to note that the minimum contrast of 3:1 is only the absolute minimum value and it is recommended to use a higher contrast, especially if the presentation is intended for recipients with visual impairments or reading difficulties.
[bookmark: _Toc160782812]7.5 No animated graphics (GIFs) are used.
What is meant by this?
Animated graphics in the form of GIF files should not be used in a presentation. Animated graphics or GIFs (Graphics Interchange Format) are file formats for graphics that can play a sequence of images in a loop to create a short animation. The looping function means that GIFs are played over and over again until the viewer closes them or scrolls further. Still images can also be converted to GIF format, but this significantly reduces the quality. 
Why is it important?
The use of animated graphics should not be used in the design of accessible digital content. It is important to note that GIFs generally do not offer the option of pausing or stopping the animation, which makes it difficult for recipients with concentration difficulties, for example, to grasp the content or concentrate on content outside the animation. Fast movements or flickering effects can also trigger seizures in some recipients with photosensitivity.
How can I implement/check it?
To search specifically for GIFs in your presentation, you can check the slides manually. Click on each slide and visually check whether a GIF is present.
Alternatively, you can use the animation area in PowerPoint to search for animations, including GIFs, in your presentation:
1. Switch to the "Animations" tab in the menu bar at the top.
2. Click on "Animation area" in the "Advanced" group.
3. The animation area opens on the right-hand side of the screen. Here you can see an overview of all the animations in your presentation.
4. Check the animations for the presence of GIFs. A GIF is normally displayed as an "image" in the list of animations.

[bookmark: _Toc160782813]8. Table 
[bookmark: _Toc160782814]8.1 Tables are created via "Insert table". 
What is meant by this? 
To create a table in PowerPoint, the "Insert table" function must be used. If you select this function, you can specify the desired number of columns and rows for the table. An empty table is then inserted into the presentation, which can be filled with content or supplemented with additional columns and rows. 
Why is it important? 
Careful creation of tables is particularly important to ensure that the content of a presentation is accessible and can be perceived by all recipients. In particular, users of screen readers and speech output devices who are dependent on an acoustic output of texts require clear structures in tables in order to make sense of the content.
If a table is not inserted or structured correctly, this can lead to various problems. For example, the screen reader may not display the content in the correct order or in full. It can also happen that cells that belong together in terms of content are not recognised as a unit, which can lead to confusion or errors in interpretation.
How can I implement/check it?
Here is a guide for you on how to use the "Insert table" function in PowerPoint:
1. Navigate to the slide on which you would like to insert the table. Click on the "Insert" tab in the top menu bar of PowerPoint.
2. Click on the "Table" button or, if you are using Mac, on "Insert table" and a drop-down menu will open.
3. You have several options in the drop-down menu: You can either create a new table or insert a table from an external source. If you want to create a new table, move the mouse pointer over the grid pattern in the drop-down menu and click on it. 
4. When you create a new table, an empty table is inserted into the presentation. You can adjust the size of the table by dragging the mouse over the edge of the table and adjusting the size accordingly.
5. Click in a cell of the table and start entering your text or data. 

[bookmark: _Toc160782815]8.2 All column headings are marked as "Heading", all row headings (if available) as "First column".
What is meant by this? 
A clear structure in tables is achieved using column and row headings. The "Heading" displays how the content is organised in the columns, while the "First column" sorts the content within the rows. To ensure that a table can be read out correctly by a screen reader or voice output, the column and row headings should be marked as "Heading" and "First column" respectively.
If all column headings are marked as "Heading", the contents of the table can be clearly assigned. The same applies to row headings that are marked as "First column". These markings make it possible to recognise the table content correctly and clearly.
Why is it important? 
Incorrect formatting of tables can result in the content and structure of the table being unclear or incomprehensible to users of screen readers and speech output devices. For example, if column or row headings are not marked as "Heading" or "First column", the screen reader or voice output cannot interpret the structure of the table correctly and cannot understand the order within the table. As a result, important information may be lost or misinterpreted.
How can I implement/check it?
Here are instructions on how to mark column headings as "Heading" and all row headings (if available) as "First column" in PowerPoint:
1. Go to the slide containing the table you want to edit. Click on the table to select it. This activates the "Table design" tab in the menu bar.
2. Click on the "Table design" tab in the menu bar. There you will find the "Table formation options" section. There are two options within this section: "Heading" and "First column".
3. Mark the first row (column headings) as a "Header": Click on the checkbox next to "Header". This formats the first row as a header row, which means that it is visually set apart from the rest of the data in the table.
4. Mark the row headings as "First column": Click on the checkbox next to "First column". This formats the row headings as the first column, which means that they are visually set apart from the rest of the data in the table.
5. If you already have existing data in the table, you should ensure that the column and row headings are marked correctly. Check whether the formatting meets your expectations and adjust it if necessary.

[bookmark: _Toc160782816]8.3 Cells are not connected to each other.
What is meant by this? 
Each row should have the same number of columns to ensure that the content can be assigned to the correct column heading. If the cells in a table are linked together, this can lead to confusion and ambiguity, as readers cannot be sure which column heading the content must be assigned to.
Why is it important? 
If table cells are merged, this can lead to problems as the information can no longer be assigned to the corresponding column headings. This can lead to the information being interpreted incorrectly or incompletely, which can lead to errors or misunderstandings. This can happen in particular when the table is enlarged. Users of screen readers and speech output devices also face challenges in correctly assigning and interpreting the cells when they are linked together. To avoid such problems, tables should be formatted in such a way that each cell can be assigned to a specific column and the information is easy to interpret. 
How can I implement/check it?
To ensure that the cells in a table are not connected to each other, table cells should not be merged. If it is necessary to place additional information in a cell, new rows or columns can be added for this purpose. However, it remains important to ensure that each row has the same number of columns so that the content can be assigned to the correct column headings. If too much information is placed in a table, either the table should be split into several tables or an alternative display format should be selected (see 8.5).
You can check whether the cells in a table are connected to each other by checking the table for cell overlaps. In PowerPoint, you can check the table structure and detect cell overlaps by carrying out the following steps:
1. Select the table by clicking on it. This activates the "Layout" tab in the menu bar.
2. Within the "Layout" section, there are various options with which you can check the table structure.
a. To display the cell borders, click on the "Display grid lines" checkbox. This will display the lines between the cells so that you can check the exact positioning of the cells.
b. To check cell overlaps, click on the "Arrangement" section. There you can choose between the options "Move cells forwards or backwards". By moving the cells forwards or backwards, you can determine whether cells overlap or cover each other.
If you notice cell overlaps, you can adjust the table accordingly to fix the problem. You can move cells or adjust the size of cells to ensure that they do not overlap. In addition to checking the table structure, you can also check the contents in the cells to ensure that they are correct and consistent.

[bookmark: _Toc160782817]8.4 Tables have a title and a table description.
What is meant by this? 
The title and table description refer to additional information provided in a table in PowerPoint. The title describes the content or topic of the table, while the table description provides a more detailed explanation of the table and its contents, e.g. the purpose of the table, the data used or other relevant information.
Why is it important?
Adding a title and a table description is important to ensure the accessibility of the presentation. Recipients with visual impairments who are dependent on speech output or a screen reader cannot visually grasp the content of the table. The title and table description enable them to understand the context and meaning of the table and to grasp the information audibly.
How can I implement/check it?
To convert the title and table description in PowerPoint, you can follow the steps below:
1. Click on the "Insert" tab. 
2. Click on the "Text box" button and enter a meaningful title or description in the text box. 
3. Place the text box above the table, as a title and below as a description and make sure that the title of the table corresponds to the slide title. 
To check whether a table contains a title and a table description, you can use the following approach:
1. Check whether the title text is present in the table and adequately describes the content or topic of the table.
2. Check whether a separate table description is available near the table and is provided for the table.

[bookmark: _Toc160782818]8.5 Complex tables are divided into several simple tables. 
What is meant by this? 
Complex tables are tables that contain a larger number of columns and rows and may represent multiple levels of data and information. They can be used, for example, in scientific reports, financial reports or in data analysis. Complex tables often contain different types of data, including numerical, textual and graphical data.
Why is it important? 
A clear breakdown of tables is essential to ensure that they are accessible to all. This is particularly important for recipients with visual impairments or blindness, who may hear the presentation read aloud and have difficulty interpreting complex tables.
By splitting complex tables into simpler tables with clear headings and structures, the readability and comprehensibility of the presentation can be improved. Recipients with other impairments such as concentration problems or learning difficulties also benefit from this structure. 
An example of this could be a financial report table that shows various key financial figures such as turnover, profit and loss. If this table is very extensive and contains a lot of complex information, it can be difficult to interpret for some recipients. By splitting it into several tables, for example a table for turnover, a table for profit and a table for loss, the information can be presented in a clearer and more understandable way.
How can I implement/check it?
To convert a complex table into several small tables in PowerPoint, you can follow the steps below:
1. Select the complex table by clicking on it. 
2. Click on the "Layout" tab.
3. Within the "Layout" section, there are various options for editing the table.
4. Select the cells in the table that you want to convert into a separate table. You can do this by holding down the mouse button and dragging across the cells or by selecting a cell and then holding down the Shift key and selecting another cell to select a range.
5. Once the desired cells have been selected, use the key combination "Ctrl + X" to cut the selected cells from the original table.
6. Go to the place where you want to insert the new small table and right-click. Use the key combination "Ctrl + V" to insert the cut cells as a separate table.
7. Repeat the steps for each additional subset of cells that you want to convert as a separate table.
On a Mac, the "Command" key is used instead of the "Ctrl" key (also known as the "Command" key). The "Command" key is often labelled with the ⌘ symbol and fulfils similar functions to the "Ctrl" key on Windows computers.
To check your presentation for complex tables, look at the tables in the presentation. Are there any tables that you think are complex? Think about how you can divide all the information into several, simple tables. 

[bookmark: _Toc160782819]9. Video and audio 
[bookmark: _Toc160782820]9.1 Videos are embedded as online videos and not as "objects" (Internet is required for playback).
What is meant by this? 
Instead of inserting videos as separate files into the presentations, the Internet is accessed to play videos during the presentation. This means that videos are not played by uploading a file, but via a link to the Internet source of the video. 
 This means that an active internet connection is required to display the video. This means that the video used in PowerPoint presentations is not embedded as a separate file, but linked as an online video. 
Why is it important?
This way of embedding videos is important for recipients who only operate the document and the video using the keyboard. By using online videos, they can control the playback of the videos without having to access external video players or other files or rely on mouse interactions.
In addition, using videos as separate files can lead to increased file sizes, making access and transmission more difficult, as well as asynchronous working in places without internet. By linking online videos, the file size of the presentation document is reduced, making approval and sharing easier. 
How can I implement/check it?
To embed videos as online videos in PowerPoint, you can follow the steps below depending on the software:


For Mac:
1. On the Insert tab of the ribbon, select the Video option in the Media group on the far right. Then select "Online film...".
2. Paste the URL copied in step 2 into the dialogue box.
3. Click on Insert.
4. The video is added to the slide
For Windows:
1. Click on "Insert" in the menu bar.
2. Select "Video" and then "Online video".
3. Enter the URL of the video or search for a video in online video portals such as YouTube or Vimeo.
4. Select the desired video and click on "Insert".

[bookmark: _Toc160782821]9.2 Embedded online videos with relevant audio content contain a subtitle (on their video platform).
What is meant by this? 
Embedded online videos in PowerPoint presentations that contain relevant audio content must be subtitled. These subtitles are usually available on the video platform from which the video originates. They are used to present relevant audio content of the video in written form.
Embedded online videos in PowerPoint are videos that are inserted directly into a PowerPoint presentation so that they can be played while the presentation is running. Instead of adding the video as a separate file attachment or providing a link to an external video, the video is embedded in the PowerPoint file.
Why is it important? 
Subtitles are important because there are recipients who primarily absorb video content visually, cannot hear or listen at the time of viewing, have no audio output, whose native language is not German or who wish to copy or search the content of the audio track. Subtitles enable these recipients to understand the content of the video and make it accessible, regardless of their hearing ability, language skills or the presence of an audio output. Subtitles also provide a visual representation of the spoken content, making it easier to understand and receive. 
How can I implement/check it?
Within PowerPoint, subtitles can only be created manually using an external WebVTT subtitle file. You can find the instructions for this under: 
WebVTT subtitle file instructions
In addition, automatically generated subtitles can be displayed via YouTube.

[bookmark: _Toc160782822]9.3 Embedded online videos with relevant visual content contain an audio description or a full text alternative that reproduces this content
What is meant by this? 
Embedded online videos in PowerPoint presentations that contain relevant visual content should be provided with audio descriptions or full text alternatives. Audio description describes visual information in dialogue breaks that are not included in the main audio track. A full text alternative provides complete descriptions of all visual information, such as actions and expressions. 
Why is it important?
Audio descriptions or full-text alternatives enable recipients to understand and gain approval for the visual content of the video regardless of their ability to see or the presence of a monitor. It is therefore particularly important for recipients who primarily absorb video content audibly, who cannot see at the time of viewing or who do not have a monitor available. An audio description or a full text alternative are particularly important when questions relate directly to visual content in the video. These can only be answered if they can also be visually perceived or described by recipients.
How can I implement/check it? 
To check whether embedded online videos contain audio descriptions or full text alternatives, the following steps can be taken:
1. Go to the slide that contains the video.
2. Start playback of the video.
3. Check whether an audio description or a full text alternative is offered during playback. This can be in the form of audio descriptions as an additional audio track or in the form of text at the edge of the screen.
The audio description is usually provided as a separate audio film in a separate player and must be created outside of PowerPoint. This should be linked to the video or a note next to it. 
The full text alternative, on the other hand, should be reproduced in detail within the following PowerPoint slides or accessed via a link to an external document. 

[bookmark: _Toc160782823]9.4 Embedded audio clips have a transcript (as text in the slide, notes, separate slide, or link to external website).
What is meant by this?
Embedded audio clips in PowerPoint presentations should be provided with a transcript. The transcript can be displayed as text in the slide itself, in the notes, on a separate slide or as a link to an external website. The transcript contains the full text of the audio clip so that recipients who prefer to absorb the content visually can read and understand it.
A transcript is a written recording or text document that reproduces the content of a spoken audio or video. It contains the full text of the spoken words in order to make the content available to all recipients. 
Why is it important?
Recipients who prefer to record auditory content visually, cannot hear or listen at the time of reception, do not have an audio output, whose native language is not German or who wish to copy or search the content of the audio clip benefit from a transcript. The transcript enables these recipients to understand the content of the audio clip and make it accessible, regardless of their hearing ability, language skills or the availability of an audio output.
How can I implement/check it? 
To insert a transcript for embedded audio clips in PowerPoint, you can follow the steps below:
1. Go to the slide on which you want to insert the audio clip.
2. Select the "Insert" tab in the PowerPoint menu bar.
3. Click on "Audio" and select the option "Audio on my PC" or if you are using a Mac "Audio from file".
4. Select the desired audio clip and click on "OK".
5. Either insert the full text of the audio clip in the slide itself, in the notes or on a separate slide. Alternatively, you can add a link to an external website where the transcript is provided.
6. Make sure that the transcript is clear and easy to read and that it reproduces the entire content of the audio clip.
To check whether embedded audio clips contain a transcript, the following steps can be taken:
1. Open the PowerPoint presentation.
2. Go to the slide that contains the audio clip.
3. Check whether a transcript is displayed as text in the slide itself, in the notes, on a separate slide or as a link to an external website. This can be determined by reading the presentation or checking options or settings.
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